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Chapter 1: Getting Started
Learn the basics of Sage 300 ERP Payment Processing, including opening your
account with Sage Payment Solutions, using Sage Virtual Terminal, and more.

Payment Processing Overview
Payment Processing is a Sage 300 ERP program that lets you process credit
card payments from your customers. You use it with Sage Exchange, a secure
payment-processing application that integrates Sage 300 ERP with Sage
Payment Solutions.

Payment Processing Features

Payment Processing includes the following features:

l Secure, PCI-compliant payment processing. Sage 300 ERP Payment
Processing meets the Payment Application Data Security Standard (PA-DSS)
for processing transactions and storing credit card details.

l Secure storage of customer credit card information. Sage Payment
Solutions stores credit card details securely in an online vault system. This
allows you to save and reuse credit card information for your customers
without storing it in your company database, ensuring that your payment
processing is PCI compliant and reducing your exposure to credit card fraud.

l A Process Credit Card screen. This screen allows you to review, and
where applicable, edit billing information, document totals, and other
information for a transaction before you submit it to Sage Payment
Solutions for processing. After you process a transaction, it displays
transaction details and status information you can use to verify that the
transaction was processed correctly, and to look up transaction reports.

l Card reader device support. You can use a card reader device to swipe
credit cards at the point of sale, minimizing manual data entry and reducing
the risk of errors.

l Seamless integration with Accounts Receivable and Order Entry.
You can open the Process Credit Card screen from key screens in Accounts
Receivable and Order Entry to quickly pre-authorize, capture, and process
payments, or to void or refund previously processed transactions.
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Chapter 1: Getting Started

l Real-time transaction reports. Sign in to Sage Virtual Terminal to view
and export reports on transactions, batches, and expiring credit cards.

l Support for multiple currencies, banks, and merchant accounts.
Flexible processing codes allow you to select the bank, currency, and
merchant account to be used when each credit card transaction is
processed. If you use multicurrency accounting, you can set up separate
Sage Payment Solutions merchant accounts to process transactions in USD
and CAD.

l Support for Level 2 Data Credit Card Processing. Payment
Processing supports Level 2 Data Credit Card Processing by submitting
sales tax information separately from transaction totals.

l English, French, and Spanish language support.

Processing Credit Cards in Accounts Receivable and Order Entry

After you install and activate Payment Processing, screens in Accounts
Receivable and Order Entry are updated to support credit card processing. For
more information, see "About Payment Processing Transactions" (page 17).

Getting Started

For instructions on installing, activating, and setting up Payment Processing,
see "Setting Up Payment Processing" (page 7).

About Sage Payment Solutions
Sage Payment Solutions provides complete, Payment Card Industry (PCI)
compliant payment processing solutions for all business types.

Sage 300 ERP Payment Processing works exclusively with Sage Payment
Solutions to enable merchants to seamlessly process credit card transactions
directly in Sage 300 ERP. The Payment Processing program uses Sage
Exchange, a secure payment-processing application, to connect to Sage
Payment Solutions and process credit card transactions.

Integrating your ERP system with Sage Payment Solutions lets you process
credit card transactions without storing your customers' sensitive credit card
information in your database. Sage Exchange transmits credit card details
through a secure connection to Sage Payment Solutions, where they are
stored in a PCI-compliant vault, protecting you from exposure to non-
compliance penalties and credit card fraud.
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About Sage Exchange

In addition to providing integrated ERP payment processing, Sage Payment
Solutions also offers gift and loyalty card programs, merchant cash advances
and loans, non-profit and healthcare payment solutions, and more.

To apply for a Sage Payment Solutions merchant account, visit the Sage ERP
Payment Solutions website.

To learn more about Sage Payment Solutions, visit na.sage.com/sage payment
solutions.

About Sage Exchange
Sage Exchange is a secure payment-processing application that connects Sage
300 ERP to Sage Payment Solutions, enabling merchants to process credit card
transactions directly in Sage 300 ERP. This allows you to process credit card
transactions without storing sensitive credit card information in your company
database, which reduces your Payment Card Industry (PCI) compliance costs
and protects you from the risk of credit card fraud.

Downloading and Installing Sage Exchange

After activating Payment Processing, you must install Sage Exchange on every
workstation you will use to process credit card transactions.

To download Sage Exchange, visit
https://www.sageexchange.com/install/setup.exe.

Known Installation Issues

Firewall and antivirus software may prevent you from installing Sage Exchange.
To prevent installation issues, you may need to perform the following steps:

1. Add the following URLs to the safe zone in your antivirus and firewall
software:

sagepayments.net

sageexchange.com

2. Add the following files to the safe zone in your antivirus software:

Sageexchange.exe

SpsModuleSdkCl.dll
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If you experience other issues while downloading and installing Sage
Exchange, see "Sage Payment Solutions Support" (page 68) for Sage Payment
Solutions support information.

Launching Sage Exchange

Sage Exchange launches automatically when you process a transaction in
Payment Processing, and runs in your system tray.

To start Sage Exchange manually, click the Start button on the Windows
taskbar, and then click All Programs > Sage Payment Solutions > Sage
Exchange.

The first time you enter credit card details or process a transaction, you may
experience a delay while Sage Exchange launches, authenticates your
merchant account information, and opens the Sage Payment Solutions
browser form.

After the initial authentication, Sage Exchange remains open in the system
tray while Sage 300 ERP is running, so subsequent credit card transactions will
launch the Sage Payment Solutions browser form much more quickly.

About Sage Virtual Terminal
Sage Virtual Terminal is a secure website that you can use to:

l Review, process, or void current transactions

l View reports on transactions, batches, and expiring credit cards

l Export reports to an Excel spreadsheet, PDF, or XPS file

l Print receipts for credit card transactions

l Settle credit card transactions

Each transaction you process in Sage 300 ERP Payment Processing is recorded
in Sage Virtual Terminal, so you can sign in anytime to view current
transaction information and reports.

Accessing Sage Virtual Terminal

When you sign up for a Sage Payment Solutions merchant account, you'll
receive a merchant ID (VT ID), username, and password that you can use to
sign in to Sage Virtual Terminal.

To view reports on credit card transactions, batches, expiration, and more for
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About Card Reader Devices

your Sage Payment Solutions merchant account, sign in to Sage Virtual
Terminal at https://www.sagepayments.net/virtualterminal.

For additional reporting resources, including 12-month summaries of
transactions and chargebacks, daily credit card batches for selected date
ranges, and monthly statement searches, you can also sign in to
https://www.myvirtualreports.com.

Finding Support and Resources

To learn more about Sage Virtual Terminal and find training and support
resources:

l Sign in to Sage Virtual Terminal and use the Help menu to find step-by-step
tutorials.

l Visit the Self Service Portal at na.sage.com/sage-payment-solutions to
search the Knowledge Base, browse merchant forms and resources, or
contact the Sage Payment Solutions support team.

About Card Reader Devices
Card reader devices, also called terminals or card swipe devices, allow
merchants to accept debit card payments and credit card payments by swiping
a credit or debit card through a terminal at the point of sale.

When processing credit card payments in Sage 300 ERP, you can use a
supported card reader device to swipe a customer's card, eliminating the need
to manually enter card information and reducing the risk of data entry errors.

Sage Payment Solutions offers new and refurbished Class A-Certified card
reader devices from leading industry manufacturers, including countertop and
wireless solutions. For more information, visit na.sage.com/sage payment
solutions.
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Chapter 2: Setting Up
Payment Processing

Learn about security authorizations, processing codes, adding and maintaining
credit cards, and other information you need to set up Payment Processing.

Setting Up Payment Processing
To use Payment Processing, you must have the current versions of Accounts
Receivable 2014 and Order Entry 2014 installed and activated.

You must also apply for a separate Sage Payment Solutions merchant account
for each currency in which you will process credit card transactions. To apply
for a Sage Payment Solutions merchant account, visit the Sage ERP Payment
Solutions website.

To set up Payment Processing:

1. Download Sage Exchange and install it on each workstation you will use to
process credit card payments. For details and instructions, see "About Sage
Exchange" (page 3).

2. In Common Services, use the PMT Options screen to select options that
specify how you pre-authorize and process credit card payments. For more
information, see "PMT Options Screen" (page 41).

3. In Common Services, use the PMT Processing Codes screen to set up
processing codes that specify the bank, currency, and merchant account
information to be used when processing credit card transactions. For more
information and instructions, see "About Processing Codes" (page 9) and
"Adding, Editing, or Deleting Processing Codes" (page 11).

4. Set up Accounts Receivable, Order Entry, and Payment Processing security
authorizations for Sage 300 ERP users. For more information, see "Payment
Processing Security Authorizations" (page 8).

Because Payment Processing integrates with Order Entry and Accounts
Receivable, the system administrator may also need to assign additional
security authorizations to users for tasks related to those programs.

To pre-authorize credit card payments and void pre-authorizations in Order
Entry, you must have Payment Processing Card Transaction Processing
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security authorization. If you need to process (capture) and void credit
card payments in Order Entry, you must also have the following security
authorizations:

Order Entry: Invoice Entry

Accounts Receivable: Receipt Entry

5. On the A/R Payment Codes screen, specify the payment type SPS Credit
Card for each payment code you will use when processing credit card
transactions.

6. If you want to enable Accounts Receivable users to void credit card
transactions, or to process payment for a credit card transaction after
printing a receipt or deposit slip, open the A/R Options screen and select
the Allow Edit After Receipt Printed and Allow Edit After Deposit
Slip Printed options on the Transactions tab. (If you do not select these
options, the Charge and Void buttons are disabled on the A/R Receipt
Entry screen).

7. On the Accounts Receivable and Order Entry screens you will use to
process credit card transactions, select File > Settings and verify that the
Auto Clear option is not selected. (If Auto Clear is selected, a new entry
appears when you click Add, and you must reopen the entry you just
added in order to click the Charge button.)

For a list of screens you use to process credit card transactions in Accounts
Receivable and Order Entry, see "About Payment Processing Transactions"
(page 17).

8. To add credit card information for Accounts Receivable customers, open
the A/R Customers screen, select a customer, click the Credit Card tab,
and click the New button. For more information, see "Adding, Editing, or
Deleting a Credit Card for a Customer" (page 13).

Payment Processing Security Authorizations
If your Sage 300 ERP system requires user passwords and security profiles,
the system administrator must assign security authorizations to users for
tasks related to Payment Processing screens.

Because Payment Processing integrates with Order Entry and Accounts
Receivable, the system administrator may also need to assign additional
security authorizations to users for tasks related to those programs.

To pre-authorize credit card payments and void pre-authorizations in Order
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About Processing Codes

Entry, you must have Payment Processing Card Transaction Processing security
authorization. If you need to process (capture) and void credit card payments in
Order Entry, you must also have the following security authorizations:

l Order Entry: Invoice Entry

l Accounts Receivable: Receipt Entry

For information on activating security and setting up security groups, refer to
the System Manager Help.

Security
Authorization

Description

Setup
Maintenance

SetupMaintenance authorization allows you to use Payment
Processing setup screens to select setup options, and to view, add,
edit, and delete processing codes andmerchant account
information.

Customer Card
Maintenance

Customer CardMaintenance authorization allows you to add, edit,
and delete customer credit card information in Payment Processing
and Accounts Receivable.

Card
Transaction
Processing

Card Transaction Processing authorization allows you to process the
following transactions in Payment Processing, Accounts Receivable,
and Order Entry:

l Pre-authorize a credit card payment

l Void a pre-authorized credit card payment

l Capture a pre-authorized credit card payment

l Process a credit card payment

l Void a credit card payment

l Void a credit card refund

Note: For all transaction types except pre-authorizing payments
and voiding pre-authorizations, you require additional security
authorizations in Order Entry and Accounts Receivable.

Payment Processing Security Authorizations

About Processing Codes
A processing code specifies the bank, currency, and merchant account that will
be used to process a credit card transaction. Before you can process credit card
transactions in Accounts Receivable or Order Entry, you must set up at least one

User's Guide 9



Chapter 2: Setting Up Payment Processing

processing code with the merchant ID and merchant key for a Sage Payment
Solutions merchant account.

On the PMT Processing Codes setup screen, you can create multiple processing
codes to specify different combinations of merchant account, currency, and
bank.

Example:
Say you use separate merchant accounts to process credit card transactions
for your web store and retail outlet, but you use the same bank and currency
for each account. You could set up two processing codes called WEBSTORE
and RETAIL that use the same bank and currency, and then specify the
merchant account to be used for each code.

After setting up processing codes, you select a processing code when entering
a credit card transaction in Accounts Receivable or Order Entry, or when
entering credit card information for a customer in Accounts Receivable.

Using Merchant Account Information

You can use the same merchant account information in multiple processing
codes. However, each merchant code is linked to a single currency, so all
processing codes that use a common merchant account must also use the
currency for that merchant account.

If you use multicurrency accounting, you must apply for a Sage Payment
Solutions merchant account for each currency in which you will process credit
card transactions.

For more information, or to apply for a merchant account, visit the Sage ERP
Payment Solutions website.

Modifying and Deleting Processing Codes

You can use the PMT Processing Codes screen to modify and delete processing
codes you have set up, as long as they have not been specified for saved
credit cards or used in any transactions.

If a processing code has been specified for a saved credit card in Accounts
Receivable, or if it has been used to process a credit card transaction, you
cannot modify or delete the processing code.
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Adding, Editing, or Deleting Processing Codes
A processing code specifies the bank, currency, and merchant account that will
be used to process a credit card transaction.

You can use the same merchant account information to create multiple
processing codes. However, merchant codes are currency-specific, so all
processing codes that use a common merchant account must also use the
currency for that merchant account.

For more information about processing codes, or for help using the fields on the
Processing Codes screen, see "About Processing Codes" (page 9).

Before you start:

l You must have at least one Sage Payment Solutions merchant account for
each currency in which you will process credit card transactions. For more
information, or to apply for a merchant account, visit na.sage.com/sage
payment solutions.

To add a processing code:

1. Open  Common Services > Payment Processing > PMT Setup >
Processing Codes.

2. Enter basic information for the processing code.

a. In the Processing Code field, enter a name for the processing code. For
example, you might create a name that reflects the context in which the
code will be used (such as WEBSTORE) or the bank and currency (such as
SEATACUSD).

b. In the Description field, enter a description that will help users select
this code when it appears in a Finder or list.

c. In the Bank field, specify the bank that will process transactions that use
this code.

Note: When you are processing a credit card transaction that uses this
processing code, if you select a bank other than the one that was
specified on the Processing Codes screen, an error message informs
you that the bank code does not match the one specified for the
processing code.

d. In the Currency field, select the currency in which transactions that use
this code will be processed.
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Note: When you are processing a credit card transaction that uses
this code, if you select a currency other than the one that was
specified for this code, an error message informs you that the
currency does not match the one specified for the processing code.

3. Enter and validate merchant account information.

a. In the Merchant ID field, enter the merchant ID for the Sage Payment
Solutions merchant account you will use to process transactions that
use this code.

b. In the Merchant Key field, enter the merchant key for the Sage
Payment Solutions merchant account.

The merchant key you enter is encrypted and replaced with asterisks
(*) for security purposes.

c. Click the Validate button to validate the merchant ID and merchant
key you entered.

A message informs you whether the merchant account information you
entered is valid.

4. Click Add to add the processing code.

After adding processing codes

l Set up payment codes in Accounts Receivable to support credit card
payments. For details, see "Setting Up Payment Processing" (page 7).

To edit a processing code:

Note: If a processing code has been specified for a saved credit card in
Accounts Receivable, or if it has been used to process a credit card
transaction, you cannot modify or delete the processing code.

1. Open  Common Services > Payment Processing > PMT Setup >
Processing Codes.

2. In the Processing Code field, enter or select the code you want to edit.

3. Make your changes to the processing code.

Tip: If you are changing merchant information, click Validate to ensure
that the new information you entered is valid.

4. Click Save.
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To delete a processing code:

Note: If a processing code has been specified for a saved credit card in
Accounts Receivable, or if it has been used to process a credit card
transaction, you cannot modify or delete the processing code.

1. Open  Common Services > Payment Processing > PMT Setup >
Processing Codes.

2. In the Processing Code field, enter or select the code you want to delete.

3. Click Delete.

Adding, Editing, or Deleting a Credit Card for a Customer
General information about a credit card is stored in the Accounts Receivable
customer record. This information includes the card ID, description, processing
code, billing information, comments, and whether or not the card should be the
default for the customer.

Credit card details (card number and expiration date) are not stored in the
Accounts Receivable customer record. To add these details, you click the Edit
Card Details button on the A/R Credit Card Information screen, and then enter
the information on the Sage Payment Solutions browser form. The information
is stored in an online "vault" managed by Sage Payment Solutions, and is not
saved in your company database.

Note: You can use a saved credit card for a transaction only if the processing
code for the card matches the processing code for the transaction.

Before you start:

l Sage Exchange must be installed and running on the workstation you are
using.

l You must have a working Internet connection.

To add credit card information for a customer:

1. Open Accounts Receivable > A/R Customers > Customers, and then
select a customer record.

2. Click the Credit Card tab.
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3. Click the New button.

The A/R Credit Card Information screen appears.

4. Set up the credit card record.

a. In the Card ID field, enter a short name for the card (for example,
VISA).

b. In the Description field, enter a short description (for example,
Aeroplan Visa Card).

c. If you use multiple processing codes, enter a processing code in the
Processing Code field. (If you use a single processing code, this field
displays that processing code.)

The bank and currency associated with the processing code appear in
the Bank and Currency fields.

d. If you want this card to be selected by default when you process credit
card transactions for this customer, select the Use This as Default Card
option.If you use multicurrency accounting, the card will be used as the
default only for transactions where the currency for the transaction
matches the currency specified for the processing code this card uses.

5. Enter billing details for the cardholder.

Tip: When entering billing details, you can select the Same as
Customer Address option to fill in billing details with name and address
information from the customer record.

6. If you want to add comments about the card, enter them in the Comments
field.

Important!
Do not record credit card details in the Comments field, including card
number, expiration date, and CVV number. Storing details in this way can
compromise credit card security and may constitute a violation of the
Payment Card Industry Data Security Standard (PCI DSS).

If a security breach occurs, merchants that do not comply with PCI DSS
may be subject to fines, card replacement costs, forensic audits, and
other penalties.

7. Enter credit card details.
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a. Click the Add Card Details button.

The Sage Payment Solutions browser form appears.

b. Enter the card number and select the expiration date, and then click
Submit.

Sage Payment Solutions creates a new entry in its online "vault" and
saves the credit card details. The browser form closes, and credit card
details appear on the A/R Credit Card Information screen, with the first
12 digits of the credit card number replaced with Xs.

8. Review the information you have entered to verify that it is correct, and then
click Add.

9. Click Close to close the screen.

To edit saved credit card information for a customer:

1. Open Accounts Receivable > A/R Customers > Customers, and then
select a customer record.

2. Click the Credit Card tab.

Saved credit cards for the customer appear in the table on the Credit Card
tab.

3. Select a credit card, and then click Open.

4. Edit credit card information.

To edit general settings and billing details, make your changes on the A/R
Credit Card Information screen.

To edit the card number or expiration date, click the Edit Card Details
button, edit the information in the fields on the Sage Payment Solutions
browser form, and then click Submit to save your changes.

5. Click Save to save your changes.

6. Click Close to close the screen.

To delete a saved credit card:

1. Open Accounts Receivable > A/R Customers > Customers, and then
select a customer record.

2. Click the Credit Card tab.

3. Select the credit card record you want to delete, and then click Delete.
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Use Sage 300 ERP Payment Processing to pre-authorize, process, void, and
refund credit card payments.

About Payment Processing Transactions
Payment Processing integrates seamlessly with key screens in Order Entry and
Accounts Receivable, allowing you to process credit cards while working in
Sage 300 ERP.

You use the integrated screens in Accounts Receivable and Order Entry to
launch the PMT Process Credit Card screen, where you enter or review billing
information, order totals, and credit card details. From this screen, you launch
the Sage Payment Solutions browser form, where you complete the
transaction.

After Sage Payment Solutions processes the transaction, transaction details
and a status message appear on the Process Credit Card screen.

Processing Credit Cards in Accounts Receivable

After you install and activate Payment Processing, the following Accounts
Receivable screens are updated to support credit card processing:

l A/R Customers. A Credit Card tab appears on the A/R Customers screen
and allows you to view, add, edit, and delete credit card records for
customers.

l A/R Credit Card Information. An A/R Credit Card Information screen
allows you to drill down from screens in Accounts Receivable and Order
Entry to view, edit, or delete credit card information.

l A/R Invoice Entry. When you select a payment code that uses the SPS
Credit Card payment type, you can process a credit card prepayment for an
invoice.

l A/R Payment Codes. A payment type called SPS Credit Card appears in
the list of available selections for payment codes. You must select this
payment type for each payment code you will use when processing credit
card transactions.
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l A/R Receipt Entry. When you select a payment code that uses the SPS
Credit Card payment type, you can process a credit card transaction for a
prepayment, receipt, unapplied cash, or miscellaneous receipt.

l A/R Refund Entry. You can refund a transaction that was paid by credit
card. The refund can be paid by cash or check, or you can apply it to the
card that was used for the transaction.

Processing Credit Cards in Order Entry

After you install and activate Payment Processing, the following Order Entry
screens are updated to support credit card processing:

l O/E Invoice Entry. Depending on the options you select on the PMT
Options screen, a Capture button allows you to capture a pre-authorized
credit card payment for a shipment.

l O/E Order Entry.Pre-authorize and Capture buttons allow you to pre-
authorize and capture a credit card payment for an order.

l O/E Prepayments. When you select a payment code that uses the SPS
Credit Card payment type, you can process a credit card prepayment for an
order.

l O/E Capture Payments With Invoices . An O/E Capture Payments With
Invoices screen allows you to capture and invoice pre-authorized credit
card payments for multiple Order Entry documents.

l O/E Shipment Entry. A Capture button allows you to capture a pre-
authorized credit card payment for an order.

About Pre-authorizing, Capturing, and Forcing Credit Card
Payments

You pre-authorize a credit card payment when you want to verify that
sufficient credit exists on a customer's credit card before processing a sale.

When you create a pre-authorization, the cardholder's credit limit is reduced
by the amount of the pre-authorization until the pre-authorization is captured
or expires.

After pre-authorizing a payment, you can capture (process) the payment or
void the pre-authorization. In Order Entry, you can also use the O/E Capture
Payments With Invoices screen to capture and invoice pre-authorized
payments for multiple Order Entry documents.
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About Pre-authorizing, Capturing, and Forcing Credit Card Payments

If a pre-authorization has expired recently, you may be able to force a payment
for the pre-authorized amount.

Pre-authorizing Payments

On the O/E Order Entry screen, you can click the Pre-authorize button to pre-
authorize a credit card payment.

The amount of a pre-authorization does not need to match the amount captured
in the final sale. The captured amount may be more (as when a restaurant
customer adds a tip) or less (as when a service station customer swipes a credit
card, and then purchases fuel that costs less than the amount pre-authorized for
a fill-up).

Important!
If it is likely that more than seven days will pass before an order is shipped,
you should not pre-authorize a credit card payment for the order. If you do,
the pre-authorization may expire, in which case your merchant service
provider will charge a fee. (Credit card pre-authorization in Sage Payment
Solutions expires after approximately seven days.)

Rather than pre-authorize a credit card payment, you can process an initial
prepayment when the order is created, and then process the balance when the
order is shipped.

For more information, see "Pre-authorizing a Credit Card Payment" (page 27).

Capturing Pre-authorized Payments

You capture a pre-authorized credit card payment when you are ready to
process payment for goods that you have shipped, or for goods or services that
a customer has received.

You can capture a pre-authorization only once. After you capture it, the pre-
authorization is released in full, regardless of whether the amount captured
matches the amount that was pre-authorized.

On some Order Entry transaction screens, you can click the Capture button to
capture (process) a pre-authorized credit card payment. This button appears on
the O/E Order Entry and O/E Shipment Entry screens, and may also appear on
the O/E Invoice Entry screen (depending on the options you selected on the PMT
Options screen).

In Order Entry, you can also use the O/E Capture Payments With Invoices
screen to capture and invoice pre-authorized payments for multiple Order Entry
documents.
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For more information about capturing credit card payments, see the following
topics:

l "PMT Options Screen" (page 41)

l "Capturing a Pre-authorized Credit Card Payment" (page 31)

l "Capturing and Invoicing Pre-Authorized Credit Card Payments" (page 21)

Forcing Payment for Expired Pre-authorizations

If a pre-authorization has expired, you may be able to force a payment for the
pre-authorized amount.

Note: Forced transactions may be subject to higher fees than regular
transactions, depending on the terms of your agreement with your merchant
service provider.

You can force a payment if the pre-authorization has expired recently
(typically within 30 days), and if you used a saved credit card for the pre-
authorization (that is, you did not select the Enter A Card For One-Time
Use option when processing the pre-authorization).

If you attempt to use the PMT Process Credit Card screen to capture an
expired pre-authorization that cannot be forced, a message informs you that
you must create a new pre-authorization or prepayment.

If you are using the O/E Capture Payments With Invoices screen to capture
and invoice multiple pre-authorized payments, Sage 300 ERP attempts to
force all expired pre-authorizations. If an expired pre-authorization cannot be
forced, a message informs you that the payment could not be processed.

Voiding Existing Pre-authorizations

On the O/E Order Entry screen, you can click the Void Pre-auth button to
open the O/E Pre-authorization screen, and then click Void to void an existing
pre-authorization.

Merchant service providers charge a fee for voiding a credit card pre-
authorization. However, this fee is lower than the fee that is charged if you do
not void or capture a pre-authorization and allow it to expire. For this reason,
we recommend that you void any pre-authorization that will not be captured.

For more information, see "Voiding a Credit Card Pre-authorization" (page
34).
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Capturing and Invoicing Pre-Authorized Credit Card Payments
You capture a pre-authorized credit card payment when you are ready to
process payment for goods that you have shipped, or for goods or services that
a customer has received.

In Order Entry, you can use the O/E Capture Payments With Invoices screen to
capture and invoice pre-authorized credit card payments for multiple orders or
shipments in a batch. For more information about the O/E Capture Payments
With Invoices screen, see the Order Entry help.

Note: You can also use O/E transaction entry screens to capture individual
pre-authorized payments by document. For more information, see "Capturing
a Pre-authorized Credit Card Payment" (page 31).

Before you start:

l A credit card pre-authorization must exist for one or more Order Entry
documents. For instructions on creating a credit card pre-authorization, see
"Pre-authorizing a Credit Card Payment" (page 27).

l Sage Exchange must be installed and running on the workstation you are
using to capture the pre-authorized payments. For more information, see
"About Sage Payment Solutions" (page 2).

l You must have a working Internet connection.

To capture and invoice pre-authorized credit card payments:

1. Open Order Entry > O/E Transactions > Capture Payments with
Invoices.

2. In the A/R Receipt Batch Date field, specify the date for the receipt batch
(or batches) that will be created when you capture pre-authorized
payments.

Note: If you process payments that use multiple processing codes, a
separate Accounts Receivable receipt batch is created for each processing
code.

3. If you want to filter documents by processing code or document number,
specify criteria.

a. In the From/To Processing Code fields, specify a range of processing
codes to view, or accept the default entries to view pre-authorized
payments for all processing codes. (A processing code specifies the
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bank, currency, and merchant account that will be used to process a
credit card transaction.)

b. In the From/To document number fields, specify a range of shipment
numbers and/or order numbers to view, or accept the default entries to
view pre-authorized payments for all documents.

Note: If you specify ranges of both shipment numbers and order
numbers, only pre-authorized payments that match all criteria you
specify will appear in the table.

c. Click the Go button.

Documents that match the criteria you specified appear in the table.

4. If you do not want to capture and invoice pre-authorized payments for all
documents that appear in the table, set the value in the Apply column to
"No" for those documents, and then select documents for which to process
payments.

To set the value in the Apply column, select a row, and then double-
click the Apply column or press the spacebar.

If you want to set this value to "No" for all documents, click the Apply
None button.

If you want to set this value to "Yes" for all documents again, click the
Apply All button.

5. If you want to print invoices and/or receipts after you capture payments
and create invoices, select the Print Invoices After Capture and/or
Print Receipts After Capture options. 

If you select Print Invoices After Capture, the O/E Invoices report
screen opens after Sage 300 ERP processes payments and creates
invoices. By default, the numbers of the first and last invoice in the new
batch are specified in the From Invoice and To Invoice fields, and the
Include Invoices Already Printed option is cleared.

If you select Print Receipts After Capture, the A/R Receipts report
screen opens after Sage 300 ERP processes payments and creates
invoices. By default, the numbers of the first and last Accounts
Receivable batches created while capturing payments are specified in
the From and To batch number fields.
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6. Click Capture and Invoice.

Sage Payment Solutions processes pre-authorized payments for all
documents that display "Yes" in the Apply column.

Order Entry creates an invoice for each pre-authorized payment that was
successfully processed.

Accounts Receivable creates a receipt batch with the batch date you
specified. If you use multiple processing codes, a separate receipt batch
is created for each processing code.

When processing is complete, a message displays summary information
about payments that were successfully processed. If any errors occur
while processing payments and creating invoices, a message displays
detailed information about each error.

Tip: If any payments were not processed, or if any invoices were not
created, print this message to create a record of errors that you need to
resolve.

If you select Print Invoices After Capture, the O/E Invoices report
screen opens after Sage 300 ERP processes payments and creates
invoices. By default, the numbers of the first and last invoice in the new
batch are specified in the From Invoice and To Invoice fields, and the
Include Invoices Already Printed option is cleared.

If you select Print Receipts After Capture, the A/R Receipts report
screen opens after Sage 300 ERP processes payments and creates
invoices. By default, the numbers of the first and last Accounts Receivable
batches created while capturing payments are specified in the From and
To batch number fields.

After capturing and invoicing credit card payments
If any payments could not be processed, resolve errors related to those
payments.

When you pre-authorize a credit card payment, credit card information is
validated in Sage Payment Solutions, and the cardholder's credit limit is
reduced by the amount of the pre-authorization until the pre-authorization is
captured or expires. For these reasons, it is rare for errors to occur while
capturing a payment. However, the following issues may cause a capture to
fail:
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l The pre-authorization has expired and cannot be forced. Pre-
authorizations usually expire after seven days, and you may be able to
"force" payment for an expired pre-authorization up to 30 days after expiry.
If more than 30 days have passed since the pre-authorization expired, you
may be unable to process payment.

l The pre-authorization has expired and credit card information was
not saved. If credit card information was not saved when the pre-
authorization was created, you cannot force payment after the pre-
authorization expires.

l The pre-authorization has been voided. If you or another user voided
the transaction in Sage 300 ERP or in Sage Virtual Terminal, you cannot
capture payment.

l The receipt amount is zero. You cannot capture a pre-authorized
payment if the receipt amount is zero.

l Another user modified the order or shipment during payment
processing. If another user changes the order or shipment information
during processing, the transaction may fail.

l The Internet connection was lost or interrupted. If a capture fails
due to issues with your Internet connection, you should be able to process
the transaction again successfully when the connection is restored.

l Merchant information has been changed. If you or another user
changed the merchant information or processing codes for your Payment
Processing system, capture may fail for pre-authorizations created using
the original merchant information or processing codes.

Processing a Credit Card Payment

Before you start:

l Sage Exchange must be installed and running on the workstation you are
using to process the payment. For more information, see "About Sage
Payment Solutions" (page 2).

l You must have a working Internet connection.

To process a credit card payment:

1. In Order Entry or Accounts Receivable, create or select a document for
which you want to process a credit card payment.
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Sage 300 ERP screens that support credit card payments

A/R Invoice Entry

A/R Receipt Entry

O/E Invoice Entry

O/E Order Entry

O/E Shipment Entry

2. Set up a prepayment or select a transaction type.

If you are using O/E Order Entry, Shipment Entry, or Invoice Entry

a. Click the Prepayment button.

b. Create or select a batch for the prepayment.

If you are using A/R Invoice Entry

a. If you are creating a new document, enter document details and click
Add.

b. Click the Prepay button.

c. Create or select a batch for the prepayment.

If you are using A/R Receipt Entry

On the Transaction Type list, select Receipt, Prepayment,
Unapplied Cash, or Misc. Receipt.

3. Verify that the information on the screen is correct.

a. Verify that the Payment Code field displays the correct payment code,
or select a payment code that uses the payment type SPS Credit Card.

Tip: Click the Finder to see a list of payment codes and associated
payment types.

b. If you are using the O/E Prepayments screen, verify that the Processing
Code field displays the correct processing code, or use the Finder to
select a code.

The bank code associated with the processing code appears in the Bank
Code field.
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Note: The bank and currency for the current transaction must match
the bank and currency specified for the processing code you select.

c. Verify that the Bank Code field displays the correct bank code, or
select a bank code to be used when the transaction is processed.

4. Enter remaining transaction details, and then click the Add button.

The Charge button becomes available.

5. Click Charge.

The PMT Process Credit Card screen appears. If a default credit card exists
in the customer record that uses the processing code selected for the
current transaction, that credit card is selected by default.

6. Specify a credit card.

To select a saved credit card, use the Finder .

To enter details for a new card and save the card in the customer
record, click the New button, and then add the card details on the A/R
Credit Card Information screen.

To enter details for a new credit card that will not be saved in the
customer record, select Enter a Card for One-Time Use. (You enter
card details on the Sage Payment Solutions browser form after you click
the Process Pre-authorization button.)

7. Enter or review billing details. These may be different from the information
in the Sage 300 ERP customer record. For example, the customer may be
using a company credit card, or may be authorized to use a card on behalf
of the primary cardholder.

Tip: When entering billing details, you can select the Same as
Customer Address option to fill in billing details with name and address
information from the customer record.

8. Review totals.

Note: For some transactions, you can edit the amount in the Taxes field
in order to comply with Level 2 processing requirements. When you edit
this amount, the amount in the Subtotal field is calculated automatically
by subtracting the taxes you entered from the transaction total.
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9. Click Process Payment.

The Sage Payment Solutions browser form appears.

10. Review or enter credit card details.

If you use a card reader device and did not select a saved credit card for
this transaction, you can click Swipe Card to swipe a credit card.

If you want to review these details, click the Next button on the browser
form.

11. Click Submit.

Sage Payment Solutions processes the payment. The browser form closes,
and transaction details and a status message appear on the PMT Process
Credit Card screen.

12. On the PMT Process Credit Card screen, review transaction details and
status.

13. Click Close to close the PMT Process Credit Card screen.

14. Post or save the document.

Pre-authorizing a Credit Card Payment
You pre-authorize a credit card payment when you want to verify that sufficient
credit exists on a customer's credit card before processing a sale. When you
create a pre-authorization, the cardholder's credit limit is reduced by the
amount of the pre-authorization until the pre-authorization is captured or
expires. 

The amount of a pre-authorization does not need to match the amount captured
in the final sale. The captured amount may be more (as when a restaurant
customer adds a tip) or less (as when a service station customer swipes a credit
card, and then purchases fuel that costs less than the amount pre-authorized for
a fill-up).

If you use multicurrency accounting, you can pre-authorize a credit card
payment only if the customer currency matches the currency specified for an
existing processing code. For example, if you want to pre-authorize a credit
card payment for a USD customer, USD must be specified as the currency for
an existing processing code.

Merchant service providers charge a fee for voiding a credit card pre-
authorization. However, this fee is lower than the fee that is charged if you do
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not void or capture a pre-authorization and allow it to expire. For this reason,
we recommend that you void any pre-authorization that will not be captured.

If a pre-authorization has expired, you may be able to force a payment for the
pre-authorized amount. You can force a payment only if the pre-authorization
has expired recently (typically within 30 days), and if you used a saved credit
card for the pre-authorization (that is, you did not select the Enter A Card
For One-Time Use option when processing the pre-authorization).

Note: Forced transactions may be subject to higher fees than regular
transactions.

If it is likely that more than seven days will pass before an order is shipped,
you should not pre-authorize a credit card payment for the order. If you do,
the pre-authorization may expire, in which case your merchant service
provider will charge a fee. (Credit card pre-authorization in Sage Payment
Solutions expires after approximately seven days.) Rather than pre-authorize
a credit card payment, you can process an initial prepayment when the order
is created, and then process the balance when the order is shipped.

For more information about processing codes, see "About Processing Codes"
(page 9).

For more information about pre-authorizing and capturing credit card
payments, see "About Pre-authorizing, Capturing, and Forcing Credit Card
Payments" (page 18).

Before you start:

l Sage Exchange must be installed and running on the workstation you are
using to pre-authorize the payment. For more information, see "About Sage
Payment Solutions" (page 2).

l You must have a working Internet connection.

To pre-authorize a credit card payment:

1. Open Order Entry > O/E Transactions > Order Entry.

2. Create or select an order for which you want to pre-authorize a credit card
payment.

3. Click Pre-authorize.

The O/E Pre-authorization screen appears. The Pre-authorization
Amount field displays the order total (including taxes).
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4. Review the information on the screen.

a. Verify that the Payment Code field displays the correct payment code,
or select a payment code that uses the payment type SPS Credit Card.

Tip: Click the Finder to see a list of payment codes and associated
payment types.

b. Verify that the Processing Code field displays the correct processing
code, or select a processing code.

The bank code associated with the processing code appears in the Bank
Code field.

Note: The processing code you select must use the same bank and
currency as the current transaction.

5. Click Pre-authorize.

The PMT Process Credit Card screen appears.

6. Specify a credit card.

To select a saved credit card, use the Finder .

To enter details for a new card and save the card in the customer record,
click the New button, and then add the card details on the A/R Credit
Card Information screen.

To enter details for a new credit card that will not be saved in the
customer record, select Enter a Card for One-Time Use. (You enter
card details on the Sage Payment Solutions browser form after you click
the Process Pre-authorization button.)

7. Enter or review billing details. These may be different from the information
in the customer record. For example, the customer may be using a company
credit card, or may be authorized to use a card on behalf of the primary
cardholder.

Tip: When entering billing details, you can select the Same as Customer
Address option to fill in billing details with name and address information
from the customer record.
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8. Review totals.

Note: For some transactions, you can edit the amount in the Taxes field
in order to comply with Level 2 processing requirements. When you edit
this amount, the amount in the Subtotal field is calculated automatically
by subtracting the taxes you entered from the transaction total.

9. Click Process Pre-authorization.

The Sage Payment Solutions browser form appears.

10. Review or enter credit card details.

If you use a card reader device and did not select a saved credit card for
this transaction, you can click Swipe Card to swipe a credit card.

If you want to review these details, click the Next button on the browser
form.

11. Click Submit.

Sage Payment Solutions processes the pre-authorization. A message
displays information about the transaction.

12. On the PMT Process Credit Card screen, review pre-authorization details
and status.

13. Click Close to return to the O/E Pre-authorization screen.

After pre-authorizing a credit card payment

l After posting the order, you can capture the pre-authorization either when
the order is shipped (using the O/E Shipment Entry screen) or when the
order is invoiced (using the O/E Invoice Entry screen).

Note: The options available for capturing individual pre-authorizations
depend on the settings you specify on the PMT Options screen. For more
information, see "PMT Options Screen" (page 41).

l You can use the O/E Capture Payments With Invoices screen to process a
batch of pre-authorized payments for multiple Order Entry documents. For
more information, see "Capturing and Invoicing Pre-Authorized Credit Card
Payments" (page 21).

l If you want to void the pre-authorization, you can click the Void Pre-auth
button on the O/E Order Entry screen.
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Capturing a Pre-authorized Credit Card Payment
You capture a pre-authorized credit card payment when you are ready to
process payment for goods that you have shipped, or for goods or services that
a customer has received.

You can capture a pre-authorization only once. After you capture it, the pre-
authorization is released in full, regardless of whether the amount captured
matches the amount that was pre-authorized.

On the O/E Shipment Entry screen, when you open a document with a pre-
authorization, the Create Invoice option is selected by default. You must
create an invoice when capturing a pre-authorized credit card payment from
this screen.

Depending on the settings you specified on the PMT Options screen, you may be
required to capture a pre-authorized payment on the O/E Shipment Entry screen
before shipping an order, or you may be able to post the shipment, and then
capture the payment later when creating the invoice.

If a pre-authorization has expired, you may be able to force a payment for the
pre-authorized amount.

Note: Forced transactions may be subject to higher fees than regular
transactions.

For more information about forcing payment, see "About Pre-authorizing,
Capturing, and Forcing Credit Card Payments" (page 18).

Note: You can use the O/E Capture Payments With Invoices screen to process
a batch of pre-authorized payments for multiple Order Entry documents. For
more information, see "Capturing and Invoicing Pre-Authorized Credit Card
Payments" (page 21).

Tip: On the O/E Order Entry screen, you can use the Order Number Finder
to view pre-authorization status. If a credit card payment has been pre-
authorized but not processed for the order, the Order Has Pre-
authorization column for the order displays "Yes."

Before you start:

l A credit card pre-authorization must exist for the document. For instructions
on creating a credit card pre-authorization, see "Pre-authorizing a Credit
Card Payment" (page 27).
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l Sage Exchange must be installed and running on the workstation you are
using to capture the pre-authorized payment. For more information, see
"About Sage Payment Solutions" (page 2).

l You must have a working Internet connection.

To capture a pre-authorized credit card payment:

1. Open Order Entry > O/E Transactions.

2. Select Order Entry, Shipment Entry, or Invoice Entry.

Note: You can capture pre-authorized payments from the O/E Invoice
Entry screen only if the Require Capture of Pre-authorized
Payments at Shipment option is cleared on the PMT Options screen.

3. Select a document or order number for which a credit card payment has
been pre-authorized.

Note: On the O/E Shipment Entry screen, the Create Invoice option is
selected by default. You must create an invoice when capturing a pre-
authorized credit card payment from this screen.

4. For each item that you are shipping, enter the quantity shipped in the
Quantity Shipped field.

5. Click Capture.

The O/E Prepayments screen appears. The Payment Code, Processing
Code, and Pre-authorization Amount fields display the information that
was entered for the pre-authorization.

Note: The Receipt Amount field displays the invoice amount, rather
than the pre-authorized amount.

6. Select a batch for the prepayment, or create a new batch.

7. In the Receipt Amount field, enter the amount to capture for the pre-
authorization.

Note: When you capture a pre-authorized credit card payment, the
amount captured can be different than the amount that was pre-
authorized. For example, if a customer at a restaurant adds a tip, the
amount captured will be greater than the amount that was pre-
authorized.
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8. Click Add.

The Charge button becomes available.

9. Click Charge.

The PMT Process Credit Card screen appears.

10. Review totals.

Note: For some transactions, you can edit the amount in the Taxes field in
order to comply with Level 2 processing requirements. When you edit this
amount, the amount in the Subtotal field is calculated automatically by
subtracting the taxes you entered from the transaction total.

11. Click Process Payment.

Sage Payment Solutions processes the payment.

12. Click Close to close the PMT Process Credit Card screen, and then the O/E
Prepayments screen.

13. Post the document.

Voiding a Credit Card Payment
If you want to void a credit card prepayment in Order Entry, you must do so
before posting the order, shipment, or invoice. After you post, the prepayment
is cleared and posted to Accounts Receivable, and can be voided only in
Accounts Receivable.

If a credit card payment has not been settled in Sage Payment Solutions, you
can void the transaction in Sage 300 ERP or by signing in to Sage Virtual
Terminal.

If a transaction has been settled in Sage Payment Solutions, it cannot be
voided. If you want to refund a settled transaction, you must use the Refund
Entry screen in Accounts Receivable.

Before you start:

l A credit card payment must have been processed, but not settled by Sage
Payment Solutions. Transactions are typically settled within 24 to 48 hours.

l Sage Exchange must be installed and running on the workstation you are
using to void the payment.
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l You must have a working Internet connection.

To void a credit card payment:

1. In Order Entry or Accounts Receivable, select a document for which a
credit card payment has been processed.

Sage 300 ERP screens that support credit card payments

O/E Order Entry

O/E Shipment Entry

O/E Invoice Entry

A/R Invoice Entry

A/R Receipt Entry

2. If you are using a screen that processes credit card payments from a
Prepayments screen, open the Prepayments screen.

On the A/R Invoice Entry screen, click Prepay.

On Order Entry screens, click Prepayments.

3. Click Void.

Sage 300 ERP checks Sage Payment Solutions to determine whether the
transaction has been settled.

If the transaction has been settled in Sage Payment Solutions, an error
message informs you that the transaction cannot be voided. If you want
to refund the transaction, you must use the Refund Entry screen in
Accounts Receivable.

If the transaction has not been settled, the PMT Process Credit Card
screen appears. The credit card that was used for the payment is
selected.

4. Click Void Sale.

Sage Payment Solutions voids the payment.

Voiding a Credit Card Pre-authorization
You can use the O/E Pre-authorization screen to void a pre-authorized credit
card payment for an order if the payment has not yet been processed.

Merchant service providers charge a fee for voiding a credit card pre-
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authorization. However, this fee is lower than the fee that is charged if you do
not void or capture a pre-authorization and allow it to expire. For this reason,
we recommend that you void any pre-authorization that will not be captured.

For more information, see "About Pre-authorizing, Capturing, and Forcing
Credit Card Payments" (page 18).

Tip: On the O/E Order Entry screen, you can use the Order Number Finder
to view pre-authorization status. If a credit card payment has been pre-
authorized but not processed for the order, the Order Has Pre-
authorization column for the order displays "Yes."

Before you start:

l A credit card pre-authorization must exist for the order.

l Sage Exchange must be installed and running on the workstation you are
using to void the pre-authorization. For more information, see "About Sage
Payment Solutions" (page 2).

l You must have a working Internet connection.

To void a credit card pre-authorization:

1. Open Order Entry > O/E Transactions > Order Entry.

2. Select a document for which a credit card payment has been pre-authorized.

3. Click Void Pre-auth.

The O/E Pre-authorization screen appears.

4. Click Void.

The PMT Process Credit Card screen appears.

5. Click Void Pre-authorization.

Sage Payment Solutions voids the pre-authorization.

Refunding a Credit Card Payment
You can refund a credit card transaction by cash or check, or by applying a
credit to the card used for the original transaction.

If a credit card payment has not been settled by Sage Payment Solutions, you
cannot refund the payment, but you can void the transaction in Sage 300 ERP.
For more information, see "Voiding a Credit Card Payment" (page 33).
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Before you start:

l A credit card payment must have been processed and settled in Sage
Payment Solutions, and the batch containing the transaction must have
been posted in Sage 300 ERP.

Note: If the transaction you are refunding was entered in Order Entry,
you must run Day End Processing before you can select the transaction on
the A/R Refund Entry screen.

For instructions on processing a credit card payment, see "Processing a
Credit Card Payment" (page 24).

l Sage Exchange must be installed and running on the workstation you are
using to refund the payment. For more information, see "About Sage
Payment Solutions" (page 2).

l You must have a working Internet connection.

To refund a credit card payment:

1. Open Accounts Receivable > A/R Transactions > Refund Entry.

2. Create a new refund batch or open an existing refund batch.

3. Enter general information for the refund.

a. Enter a description for the entry.

b. In the Customer Number field, type or select the customer number.

c. In the Refund Number field, accept the ***NEW*** entry to let the
program assign the refund number.

d. Enter the date and the year and period for the refund, or accept the
displayed information. (The program uses the session date and the
current year and period as defaults for the refund.)

4. Specify the payment type.

a. If all or part of the refund is in cash, click the Cash Payment button,
and then enter the bank or cash account and the currency for the cash
refund. If you are refunding in a currency different from your functional
currency, also specify the rate type, rate date, and the exchange rate
for the refund.

b. If all or part of the refund is by check, click the Check Payment
button, and then enter the bank, currency, and check language for the
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refund. If you are refunding in a currency different from your functional
currency, also specify the rate type, rate date, and the exchange rate for
the refund.

Select the Print Check option if you are using Accounts Receivable to
print the check. If you have issued a manual check, do not select the
option, but enter the check number in the field provided.

Note: When you add details for the cash refund later, the program
updates the Check Amount field.

5. In the Detail table, add refund details.

Note: When refunding a credit card payment, you can enter only a single
detail line for the refund.

For each detail:

a. Press the Insert key on your keyboard to insert a detail line.

b. In the Document Number column, enter the number for the document
you are refunding, or use the Finder to select it.

The program fills in information about the selected document, including
the document type, original amount, current and pending balances, and
whether the document is job related.

c. In the Payment Type column:

If you are applying a credit to the card used for the original
transaction, verify that the payment type SPS Credit Card is selected.

If you are issuing the refund by cash or check, double-click the
Payment Type field and select the payment type.

d. If you are applying the refund to a credit note paid by credit card, select
the receipt number associated with the payment from the list in the
Receipt No. field.

e. In the Payment Amount column, enter the amount you are refunding
for the selected document. You can refund any amount up to the total for
the original document.

6. Click Add to add the refund entry.

The Credit button becomes available.
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7. If all or part of the refund is by credit card, apply the credit to the card.

a. Click the Credit button.

The PMT Process Credit Card screen appears in Credit mode, with the
card used for the original transaction selected. (You cannot select
another card because you must apply the refund to the card used for
the original transaction.)

b. Click the Apply Credit button.

Sage Payment Solutions applies the credit to the card used for the
original transaction. Transaction details and a status message appear
on the PMT Process Credit Card screen.

c. Click Close to close the screen.

8. Click Save to save the refund entry.

Voiding a Credit Card Refund
You can void a credit card refund in Sage 300 ERP or by signing in to Sage
Virtual Terminal. For more information, see "About Sage Virtual Terminal"
(page 4).

Before you start:

l A credit card refund must have been processed in Sage Payment Solutions,
and must not have been settled. (Transactions are typically settled within
48 hours.)

l Sage Exchange must be installed and running on the workstation you are
using to void the refund. For more information, see "About Sage Payment
Solutions" (page 2).

l You must have a working Internet connection.

To void a credit card refund:

1. Open Accounts Receivable > A/R Transactions > Refund Entry.

2. Select a document for which a Sage Payment Solutions credit card
payment has been refunded.

3. Click Void.

The PMT Process Credit Card screen appears and displays details for the
refunded transaction.
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4. Click Void Refund.

Sage Payment Solutions voids the refund. Transaction details and a status
message appear on the PMT Process Credit Card screen, and the
authorization code is cleared.

Note: If the refund has been settled in Sage Payment Solutions, it cannot
be voided.

5. Close the PMT Process Credit Card screen.
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Learn how to find and use Payment Processing screens. Each screen guide
includes navigation information, field help, and a list of tasks you can use the
screen to perform.

PMT Options Screen

To open this screen:
Open Common Services > Payment Processing > PMT Setup > Options.

Related tasks:

l "Setting Up Payment Processing" (page 7)

l "Adding, Editing, or Deleting Processing Codes" (page 11)

Overview

Use the PMT Options screen to select options that specify how you pre-
authorize and process credit card payments in Sage Payment Solutions.

Note:
l The Processing tab appears only if you have installed and activated Order
Entry.

l You cannot save changes to options that affect Payment Processing
integration with Order Entry until all other users have left Order Entry and
all Order Entry screens are closed.

On the Processing tab, use the Require Capture of Pre-authorized
Payments at Shipment option to specify whether Order Entry users are
required to process ("capture") a credit card payment that has been pre-
authorized for an order before posting a shipment.

l If you select this option, youmust capture the pre-authorized payment
and select the option to create an invoice before posting a shipment.

l If you clear this option, you can post the shipment without capturing the
pre-authorized payment, and then capture the payment when creating the
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invoice. (You can also capture the payment when shipping, but are not
required to do so before posting the shipment.)

Note: After posting a shipment for an order with a pre-authorization, you
must capture the pre-authorized payment and invoice the shipment before
you can create another shipment for the order.

Fields and Controls

Company tab
On the Company tab, enter contact information for your Payment
Processing system.

Note: To change your company name and address, or to change contact
information at the company level, use the Company Profile screen in
Common Services.

Contact Name
Enter the name of a contact person, position, or department for your
Payment Processing system.

Fax Number
Enter a fax number for your Payment Processing system.

Telephone
Enter a telephone number for your Payment Processing system.

Processing tab
Use the options on this tab to specify general options for processing credit
card transactions.

Note: The Processing tab appears only if you have installed and activated
Order Entry.

Require Capture of Pre-authorized Payments at Shipment
Specify whether Order Entry users are required to process ("capture") a
credit card payment that has been pre-authorized for an order before
posting a shipment.
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l If you select this option, youmust capture the pre-authorized
payment and select the option to create an invoice before posting a
shipment.

l If you clear this option, you can post the shipment without
capturing the pre-authorized payment, and then capture the payment
when creating the invoice. (You can also capture the payment when
shipping, but are not required to do so before posting the shipment.)

Note: After posting a shipment for an order with a pre-authorization,
you must capture the pre-authorized payment and invoice the
shipment before you can create another shipment for the order.

Warn Before Forcing Expired Pre-authorizations
Select this option if you want a warning message to appear when a user
tries to force payment for an expired pre-authorization.

For more information about forcing payment, see "About Pre-authorizing,
Capturing, and Forcing Credit Card Payments" (page 18).
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PMT Processing Codes Screen

To open this screen:
Open  Common Services > Payment Processing > PMT Setup >
Processing Codes.

Related tasks:

l "Setting Up Payment Processing" (page 7)

l "Adding, Editing, or Deleting Processing Codes" (page 11)

Overview

Use the Processing Codes screen to set up one or more processing codes that
you will use to process credit card payments with Sage Payment Solutions.

A processing code specifies the bank, currency, and merchant account that
will be used to process a credit card transaction. For more information about
processing codes, see "About Processing Codes" (page 9).

After you enter a Merchant ID and Merchant Key on this screen, you can click
the Validate button to test the merchant ID and merchant key you have
entered for a processing code. Sage 300 ERP checks Sage Payment Solutions,
and a message informs you whether the information you entered is valid.

For more information about merchant accounts, or to apply for a Sage
Payment Solutions merchant account, visit the Sage ERP Payment Solutions
website.

Fields and Controls

Buttons

Add
Click Add to add a new processing code to your system.

For more information, see "Adding, Editing, or Deleting Processing
Codes" (page 11).

Delete
Click Delete to delete a processing code.
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Note: If a processing code has been specified for a saved credit card in
Accounts Receivable, or if it has been used to process a credit card
transaction, you cannot modify or delete the processing code.

For more information, see "Adding, Editing, or Deleting Processing Codes"
(page 11).

Save
Click Save to save changes you have made to an existing processing
code.

Tip: If you have changed the merchant ID or merchant key, click
Validate before saving to verify that the information you have entered
is valid.

For more information, see "Adding, Editing, or Deleting Processing Codes"
(page 11).

Validate
Click Validate to test the merchant ID and merchant key you have
entered for a processing code. Sage 300 ERP checks Sage Payment
Solutions, and a message informs you whether the information you
entered is valid.

Bank
Enter the bank code of the bank that will process transactions that use this
processing code.

When you are processing a credit card transaction that uses this processing
code, if you select a bank other than the one that was specified on the
Processing Codes screen, an error message informs you that the bank code
does not match the one specified for the processing code.

Currency
If you use multicurrency accounting, select the currency in which
transactions that use this code will be processed.

You must apply for a Sage Payment Solutions merchant account for each
currency in which you will process credit card transactions.

Also note that the currency you specify for this processing code must match
the currency for the merchant account you specify in the Merchant ID field.
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Description
Enter a description for the processing code.

Merchant ID
Enter the merchant ID for the Sage Payment Solutions merchant account
you want to use when processing transactions that use this processing
code.

If you use multicurrency accounting, you must apply for a Sage Payment
Solutions merchant account for each currency in which you will process
credit card transactions.

If you do not have a merchant account, visit na.sage.com/sage payment
solutions to learn more or apply.

Note: The merchant account you specify for this processing code must
use the currency you specified in the Currency field.

Merchant Key
Enter the merchant key for your merchant account with Sage Payment
Solutions. If you do not have a merchant account, visit the Sage ERP
Payment Solutions website to learn more or apply.

After you add the processing code or save changes to an existing code, the
information in the Merchant Key field is encrypted and replaced with
asterisks (*) for security reasons.

Processing Code
A processing code specifies the bank, currency, and merchant account that
will be used to process a credit card transaction.

Use this field to enter a new processing code, or to select an existing
processing code to view or edit.

Tip: If you are creating a new processing code, consider using a name
that reflects the context in which the code will be used (such as
WEBSTORE) or the bank and currency (such as SEATACUSD).
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PMT Process Credit Card Screen

To open this screen:
On a Sage 300 ERP screen that supports Payment Processing, click Pre-
authorize, Prepayment, Charge, Void, or Refund.

Note: In some cases, you must enter additional information on a pop-up
screen that appears before this screen. For example, if you are processing a
credit card prepayment in Order Entry, you must enter information about the
prepayment on the O/E Prepayments screen before processing the credit card
transaction.

Related tasks:

l "Capturing and Invoicing Pre-Authorized Credit Card Payments" (page 21)

l "Capturing a Pre-authorized Credit Card Payment" (page 31)

l "Pre-authorizing a Credit Card Payment" (page 27)

l "Processing a Credit Card Payment" (page 24)

l "Refunding a Credit Card Payment" (page 35)

l "Voiding a Credit Card Payment" (page 33)

l "Voiding a Credit Card Pre-authorization" (page 34)

l "Voiding a Credit Card Refund" (page 38)

Overview

Use the PMT Process Credit Card screen to pre-authorize, process, void, or
refund credit card transactions.

Selecting a Card

If a default card exists in the customer record and uses a processing code with
the same currency as the current transaction, that card is selected by default in
the Card ID field when you open the PMT Process Credit Card screen.

For transactions where the Card ID field is editable, you can:

l Select a saved credit card from the customer record

l Add a new credit card to be saved in the customer record
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l Add a new credit card to be used one time only

If you select the Enter a Card for One-Time Use option, card details will
not be stored in Sage Payment Solutions, and billing details will not be saved
in the customer record.

Entering Billing Details

Enter billing details for the cardholder as they appear on the credit card. If you
use Address Verification Service (AVS), the information in these fields (except
the Comments field) is verified against the information on record for the
cardholder when a transaction is processed.

The billing details you enter here may be different from the information in the
Sage 300 ERP customer record. For example, the customer may be using a
company credit card, or may be authorized to use a card on behalf of the
primary cardholder.

Important!
Do not record credit card details in the Comments field, including card
number, expiration date, and CVV number. Storing details in this way can
compromise credit card security and may constitute a violation of the
Payment Card Industry Data Security Standard (PCI DSS).

If a security breach occurs, merchants that do not comply with PCI DSS may
be subject to fines, card replacement costs, forensic audits, and other
penalties.

Reviewing Transaction Totals

When you initiate a credit card payment from Accounts Receivable or Order
Entry, totals for the transaction appear in the Totals group.

For some transactions, you can edit the amount in the Taxes field in order to
comply with Level 2 processing requirements. When you edit this amount, the
amount in the Subtotal field is calculated automatically by subtracting the
taxes you entered from the transaction total.

Processing a Credit Card Transaction

After entering or reviewing billing details and totals for a transaction, you use
the Sage Exchange browser form to process the transaction in Sage Payment
Solutions.
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To open the Sage Exchange browser form, click the button in the Credit Card
Details area. (This button may be labeled Process Payment, Pre-authorize
Payment, Void Pre-authorization, Void Sale, or Apply Credit, depending
on the current transaction.)

Note:
When you capture (process payment for) a pre-authorized credit card
payment, the amount captured can be different than the amount that was pre-
authorized. For example, if a customer at a restaurant adds a tip, the amount
captured will be greater than the amount that was pre-authorized.

You can capture a pre-authorization only once. After the capture, the pre-
authorization is always released in full, regardless of whether the amount
captured is equal to or less than the amount that was pre-authorized.

Reviewing Transaction Details

After a transaction is processed by Sage Payment Solutions, information about
the transaction appears in the Transaction Details area, including the time the
transaction was processed, an authorization code, and a short message
indicating the status of the transaction.

You can use the authorization code to look up transaction details in Sage
Payment Solutions Virtual Terminal. For more information, see "About Sage
Virtual Terminal" (page 4).

Fields and Controls

Buttons
The buttons that appear on this screen depend on the type of credit card
transaction you are processing.

For example, if you previously processed a credit card payment and you
need to void the sale, the Void Sale button appears.

Apply Credit
Click Apply Credit to open the Sage Payment Solutions form in a
browser and apply a credit to a customer's card. In the browser form, you
enter the card number, expiration date, and other details as required, and
then submit the form to apply the credit.

After you apply the credit, transaction details and a status message
appear on the PMT Process Credit Card screen.
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Close
Click Close to close the screen.

Process Payment
Click Process Payment to open the Sage Payment Solutions form in a
browser and process a payment. In the browser form, you enter the
card number, expiration date, and other details as required, and then
submit the form to process payment.

After you process the payment, transaction details and a status
message appear on the PMT Process Credit Card screen.

Process Pre-authorization
Click Process Pre-authorization to open the Sage Payment Solutions
form in a browser and pre-authorize a credit card payment. In the
browser form, you enter the card number, expiration date, and other
details as required, and then submit the form to process the pre-
authorization.

After you pre-authorize the payment, transaction details and a status
message appear on the PMT Process Credit Card screen.

Void Pre-authorization
Click Void Pre-authorization to void (cancel) a previously submitted
pre-authorization.

After you void the pre-authorization, the Authorization Code field is
cleared, and a status message informs you that the pre-authorization
has been voided.

Void Sale
Click Void Sale to void a previously processed sale. After you void the
sale, the Authorization Code field is cleared, and a status message
informs you that the sale has been voided.

A transaction can be voided only before it has been settled (that is,
before the transaction has been processed by Sage Payment Solutions).
When you click the Void Sale button, Sage 300 ERP checks Sage
Payment Solutions to determine whether the transaction can be voided.
If the transaction has been settled, it cannot be voided, and you must
use the A/R Refund Entry screen to apply a credit if you want to refund
the transaction.
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Card ID
Use the Card ID field to select a saved credit card for a customer, or to add
a new credit card for processing.

l To select a saved credit card, use the Finder .

l To add a new credit card, click the New button, and then enter card
information on the A/R Credit Card Information screen.

If you want to review or edit details for a saved credit card, select the card,
and then click the Zoom button to open the A/R Credit Card Information
screen.

If you want to enter a card for one-time use, do not use the Card ID field.
Instead, select the Enter A Card For One-Time Use option.

Note: You add credit cards for a customer on the Credit Cards tab of the
A/R Customers screen.

Default Card
Select this option to set the current card as the default credit card for the
customer. When you process other credit card transactions for the customer,
this card will appear by default on the PMT Process Credit Card screen.

If you use multicurrency accounting, the card will be used as the default only
for transactions where the currency for the transaction matches the currency
specified for the card.

Description
Enter a description for the card, such as "Bank of America Mastercard."

The description appears beside the card ID in forms, tables, and lists, and
makes it easier to identify and select a card for future transactions and
inquiries.

Enter a Card for One-Time Use
Select this option if you want to process a credit card transaction without
using a saved credit card from the customer record.

Any credit card information you enter after selecting this option will not be
saved in Sage 300 ERP. If you begin to enter information and then clear the
Enter a Card for One-Time Use option, all information you have entered
will be cleared.

User's Guide 51



Appendix A: Payment Processing Screen Guides

Note: After you select this option, transaction information is saved in
Sage Payment Solutions for processing purposes, but no card information
is saved in Sage 300 ERP. If you are pre-authorizing a credit card
payment, you will be able to capture or void the pre-authorization.
However, if you want to process another transaction, you will need to re-
enter card information.

Processing Code
This field displays the processing code for the credit card transaction. This
code specifies the bank, currency, and merchant account that will be used
when the transaction is processed.

Billing Details
If you are processing a transaction using a saved credit card, review the
information in these fields to verify that it is correct. If you need to change
the information, you can click the Card ID Zoom button to open the A/R
Credit Card Information screen.

If you are entering a card for one-time use, enter credit card billing details
in these fields.

Tip: Select the Same as Customer Address option to fill in billing
details with name and address information from the customer record.

If you use Address Verification Service (AVS), the information in these
fields (except the Comments field) is verified against the information on
record for the cardholder when a transaction is processed.

Important!
Do not record credit card details in the Comments field, including card
number, expiration date, and CVV number. Storing details in this way can
compromise credit card security and may constitute a violation of the
Payment Card Industry Data Security Standard (PCI DSS).

If a security breach occurs, merchants that do not comply with PCI DSS
may be subject to fines, card replacement costs, forensic audits, and
other penalties.

Address
Enter the cardholder's address.
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Cardholder Name
Enter the name of the person to whom the card was issued. If the
cardholder has authorized an additional person to use the card, you can
use that person's name.

City
Enter the name of the city.

Comments
This field is optional. You can use it to record comments about the current
transaction.

Important!
Do not record credit card details in the Comments field, including card
number, expiration date, and CVV number. Storing details in this way
can compromise credit card security and may constitute a violation of
the Payment Card Industry Data Security Standard (PCI DSS).

If a security breach occurs, merchants that do not comply with PCI DSS
may be subject to fines, card replacement costs, forensic audits, and
other penalties.

Country
Enter the name of the country.

Same as Customer Address
Select this option to fill in Billing Details fields with name and address
information from the customer record. If necessary, you can change this
information.

If you clear this option after selecting it, customer name and address
information is cleared from Billing Details fields.

State/Province
Enter the name of the state or province.

Zip/Postal Code
Enter the zip code or postal code for the address.

Credit Card Details
The fields in this group display the credit card type, number, and expiration
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date for the selected credit card.

This information is stored securely in Sage Payment Solutions, and can be
edited only in the Sage Payment Solutions browser form (not in Sage 300
ERP).

Important!
Do not record credit card details in the Comments field, including card
number, expiration date, and CVV number. Storing details in this way can
compromise credit card security and may constitute a violation of the
Payment Card Industry Data Security Standard (PCI DSS).

If a security breach occurs, merchants that do not comply with PCI DSS
may be subject to fines, card replacement costs, forensic audits, and
other penalties.

Card Number
This field displays the last four digits of the credit card used for the
transaction, with the remaining digits replaced by Xs.

This information is stored securely in Sage Payment Solutions, and can
be edited only in the Sage Payment Solutions browser form (not in Sage
300 ERP).

Card Type
This field displays the card type (for example, Visa), and cannot be
edited in Sage 300 ERP.

Sage Payment Solutions determines card type automatically by
checking the card number.

Expiration Date
This field displays the expiration date of the credit card used for the
transaction, in the format MM/YY.

This information is stored securely in Sage Payment Solutions, and can
be edited only in the Sage Payment Solutions browser form (not in Sage
300 ERP).

Totals
These fields display tax information and totals for the transaction. For
some transactions, you can edit the amount in the Taxes field in order to
comply with Level 2 processing requirements. When you edit this amount,
the amount in the Subtotal field is calculated automatically by subtracting
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the taxes you entered from the transaction total.

Subtotal
This field displays the amount of the transaction before tax, and is added
to the amount in the Taxes field to calculate the total.

For some transactions, you can edit the amount in the Taxes field in
order to comply with Level 2 processing requirements. When you edit this
amount, the amount in the Subtotal field is calculated automatically by
subtracting the taxes you entered from the transaction total.

Taxes
This field displays the amount of tax included in the transaction, and is
added to the amount in the Subtotal field to calculate the total.

For some transactions, you can edit the amount in the Taxes field in
order to comply with Level 2 processing requirements. When you edit this
amount, the amount in the Subtotal field is calculated automatically by
subtracting the taxes you entered from the transaction total.

Total
This field displays the total amount to be pre-authorized, processed,
voided, or credited.

Transaction Details
This group displays the authorization code for a transaction, the time it was
processed, and a status message that indicates whether a payment has been
pre-authorized, processed, voided, or credited.

Authorization Code
This field displays the authorization code that Sage Payment Solutions
assigns to each transaction as it is processed.

You can use this authorization code to look up a transaction in Sage
Virtual Terminal.

Time
This field displays the time at which a transaction was processed by Sage
Payment Solutions.
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General Information

What is Payment Processing?
Payment Processing is a Sage 300 ERP program that lets you process credit
card payments from your customers. You use it with Sage Exchange, a secure
payment-processing application that integrates Sage 300 ERP with Sage
Payment Solutions.

For an overview of product features and integration with Accounts Receivable
and Order Entry, see "Payment Processing Overview" (page 1).

What features does Payment Processing include?
For an up-to-date list of features included in Payment Processing, see
"Payment Processing Overview" (page 1).

What is Sage Payment Solutions?
Sage Payment Solutions provides complete, Payment Card Industry (PCI)
compliant payment processing solutions for all business types. Sage 300 ERP
Payment Processing works exclusively with Sage Payment Solutions to enable
merchants to seamlessly process credit card transactions directly in Sage 300
ERP.

For more information, see "About Sage Payment Solutions" (page 2).

What is Sage Exchange?
Sage Exchange is a secure payment-processing application that connects Sage
300 ERP to Sage Payment Solutions, enabling merchants to process credit card
transactions directly in Sage 300 ERP. For more information, see "About Sage
Exchange" (page 3).

What is Sage Virtual Terminal?
Sage Virtual Terminal is a secure website that you can use to process credit
card transactions, and to view and export reports on transactions, batches, and
expiring credit cards. For more information, see "About Sage Virtual Terminal"
(page 4).
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Do I need to install Sage Exchange to use Payment Processing?
Yes. You must install Sage Exchange on each workstation you will use to
process credit card payments. For more information, see "About Sage
Exchange" (page 3) and "Setting Up Payment Processing" (page 7).

Can I save credit card information for a customer?
Yes. When you add a credit card, general information about the card is stored
in the Accounts Receivable customer record, and card details (card number
and expiration date) are stored in a secure online "vault" managed by Sage
Payment Solutions. For more information, see "Adding, Editing, or Deleting a
Credit Card for a Customer" (page 13).

Payment Card Industry Information

What are PA-DSS and PCI compliance?
The Payment Application Data Security Standard (PA-DSS) is the global
security standard created by the Payment Card Industry (PCI) Security
Standards Council. PA-DSS was implemented in an effort to provide the
definitive data standard for software vendors that develop payment
applications.

Sage Payment Solutions is included on the list of validated payment
applications published by the PCI Security Standards Council at
https://www.pcisecuritystandards.org/approved_companies_providers/vpa_
agreement.php.

For more information about PA-DSS and PCI compliance, including education
resources, FAQs, and compliance deadlines, visit na.sage.com/sage payment
solutions/compliance/PCI-Education-and-Resources.

What is a vault?
A vault is a secure system that stores credit card information. Sage Payment
Solutions uses a vault system to ensure that credit card information is stored
securely, allowing merchants to process payments in a PCI-compliant process
without ever storing credit card information in their own systems.

Does Payment Processing support Level 2 and Level 3 Data Credit
Card Processing?
Payment Processing supports Level 2 Data Credit Card Processing, which
requires that each transaction include card information, billing details, and
sales tax information that is submitted separately from the total transaction
amount.
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Payment Processing does not currently support Level 3 Data Credit Card
Processing, which requires that each transaction include additional line item
details and freight/duty amounts. We are working to include Level 3 processing
in a future release of Payment Processing.

Transaction Types

What is a credit card payment or sale?
A sale transaction authorizes a payment service provider to initiate a payment
from the cardholder's issuing bank to the merchant account. A sale is typically
settled within 24-48 hours, before which time it may be voided by the merchant
if there was an error or if the customer wishes to reverse the transaction.

What is a pre-authorization?
A pre-authorization temporarily reduces a cardholder's credit in order to
guarantee that funds are available for a pending transaction. For example, a
service station creates a pre-authorization when you swipe your credit card at a
gas pump and authorize a fill-up.

For more information, see "Pre-authorizing a Credit Card Payment" (page 27).

What is a capture?
When a pre-authorization exists for a credit card payment, you "capture" the
pre-authorization to complete the sale.

When you capture (process payment for) a pre-authorized credit card payment,
the amount captured can be different than the amount that was pre-authorized.
For example, if a customer at a restaurant adds a tip, the amount captured will
be greater than the amount that was pre-authorized.

You can capture a pre-authorization only once. After the capture, the pre-
authorization is always released in full, regardless of whether the amount
captured is equal to or less than the amount that was pre-authorized.

For more information, see "Capturing a Pre-authorized Credit Card Payment"
(page 31).

Can I void a pre-authorization?
You can void a pre-authorization if it has not been captured and has not expired.
(Pre-authorizations typically expire after seven days.)

Merchant service providers charge a fee for voiding a credit card pre-
authorization. However, this fee is lower than the fee that is charged if you do
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not void or capture a pre-authorization and allow it to expire. For this reason,
we recommend that you void any pre-authorization that will not be captured.

For more information, see "Voiding a Credit Card Pre-authorization" (page
34).

What is the difference between voiding a sale and issuing a credit?
Voiding a sale prevents the sale from being processed, whereas a credit
(refund) is applied against a sale that has already been processed. You can
void a sale only if the sale has not been settled by the payment service
provider.

For more information, see "Voiding a Credit Card Payment" (page 33).

Processing Transactions

What fees will I pay as a merchant using Payment Processing?
The fees you pay as a merchant using Payment Processing depend on the
details of your merchant account agreement with Sage Payment Solutions.
This can vary depending on many factors, including the number of
transactions you process per month.

For more information about Sage Payment Solutions merchant accounts and
fees, visit na.sage.com/sage payment solutions.

What happens when a transaction is processed?
Cardholder, merchant account, and transaction data are encrypted and
submitted to Sage Payment Solutions as an XML request over a secure
channel. If you are saving credit card information for an Accounts Receivable
customer, a secure vault ID is created in Sage Payment Solutions to store this
information.

After processing the transaction or storing the card details, Sage Payment
Solutions returns an XML response to Sage 300 ERP, and your customer
database is updated with details for the transaction.

How long does it take to settle a transaction?
Sage Payment Solutions credit card transactions are typically settled within
24-48 hours.

How long does a pre-authorization remain active before it expires?
Pre-authorizations typically expire after seven days.
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If it is likely that more than seven days will pass before an order is shipped, you
should not pre-authorize a credit card payment for the order. If you do, the pre-
authorization may expire, in which case your merchant service provider will
charge a fee. (Credit card pre-authorization in Sage Payment Solutions expires
after approximately seven days.)

Rather than pre-authorize a credit card payment, you can process an initial
prepayment when the order is created, and then process the balance when the
order is shipped.

Can I swipe cards for payment?
When processing credit card payments in Sage 300 ERP, you can use a
supported card reader device to swipe a customer's card, eliminating the need
to manually enter card information and reducing the risk of data entry errors.

Sage Payment Solutions offers new and refurbished Class A-Certified card
reader devices from leading industry manufacturers, including countertop and
wireless solutions. For more information, visit na.sage.com/sage payment
solutions.

How do I process a credit card payment in Sage 300 ERP?
For instructions on processing a credit card payment, see "Processing a Credit
Card Payment" (page 24).

How do I pre-authorize a credit card payment in Sage 300 ERP?
For instructions on pre-authorizing a credit card payment, see "Pre-authorizing
a Credit Card Payment" (page 27).

How do I void a credit card pre-authorization or payment in Sage 300
ERP?
For instructions on voiding a credit card pre-authorization or payment, see
"Voiding a Credit Card Pre-authorization" (page 34) and "Voiding a Credit Card
Payment" (page 33).

Can I process multiple pre-authorized payments in a single batch?
Yes. For instructions on processing multiple pre-authorized payments, see
"Capturing and Invoicing Pre-Authorized Credit Card Payments" (page 21).

Why does an error message appear when I try to process ("capture")
a pre-authorized payment?
When you pre-authorize a credit card payment, credit card information is
validated in Sage Payment Solutions, and the cardholder's credit limit is
reduced by the amount of the pre-authorization until the pre-authorization is
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captured or expires. For these reasons, it is rare for errors to occur while
capturing a payment. However, the following issues may cause a capture to
fail:

l The pre-authorization has expired and cannot be forced. Pre-
authorizations usually expire after seven days, and you may be able to
"force" payment for an expired pre-authorization up to 30 days after expiry.
If more than 30 days have passed since the pre-authorization expired, you
may be unable to process payment.

l The pre-authorization has expired and credit card information was
not saved. If credit card information was not saved when the pre-
authorization was created, you cannot force payment after the pre-
authorization expires.

l The pre-authorization has been voided. If you or another user voided
the transaction in Sage 300 ERP or in Sage Virtual Terminal, you cannot
capture payment.

l The receipt amount is zero. You cannot capture a pre-authorized
payment if the receipt amount is zero.

l Another user modified the order or shipment during payment
processing. If another user changes the order or shipment information
during processing, the transaction may fail.

l The Internet connection was lost or interrupted. If a capture fails
due to issues with your Internet connection, you should be able to process
the transaction again successfully when the connection is restored.

l Merchant information has been changed. If you or another user
changed the merchant information or processing codes for your Payment
Processing system, capture may fail for pre-authorizations created using
the original merchant information or processing codes.

When processing credit card transactions, should I record credit
card details (such as card number, expiry date, and CVV number) in
the Comments field?
No!

Do not record credit card details in the Comments field, including card
number, expiration date, and CVV number. Storing details in this way can
compromise credit card security and may constitute a violation of the
Payment Card Industry Data Security Standard (PCI DSS).
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If a security breach occurs, merchants that do not comply with PCI DSS may be
subject to fines, card replacement costs, forensic audits, and other penalties.

How can I check the status of a transaction?
To check the status of a transaction, you can use your Sage Payment Solutions
merchant account information to sign in to Sage Virtual Terminal at
https://www.sagepayments.net/virtualterminal.

For more information, see "About Sage Virtual Terminal" (page 4).

User's Guide 63

https://www.sagepayments.net/virtualterminal




Appendix C: Viewing and
Printing Reports

Learn how to view and print Payment Processing reports.

About Payment Processing Reports
When you sign up for a Sage Payment Solutions merchant account, you'll
receive a merchant ID (VT ID), username, and password that you can use to
sign in to Sage Virtual Terminal.

To view reports on credit card transactions, batches, expiration, and more for
your Sage Payment Solutions merchant account, sign in to Sage Virtual
Terminal at https://www.sagepayments.net/virtualterminal.

For additional reporting resources, including 12-month summaries of
transactions and chargebacks, daily credit card batches for selected date
ranges, and monthly statement searches, you can also sign in to
https://www.myvirtualreports.com.
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Find help, documentation, and support information for Sage Payment Solutions
and Sage 300 ERP to help keep your software and business up and running
smoothly.

Finding Help and Documentation
You can find information about setting up and using Sage 300 ERP in the Sage
300 ERP Learning Center and in the product documentation included with this
release.

Note: For technical support, visit our customer support website at
http://na.sage.com/sage-300-erp/product-support or contact your Sage
business partner.

The Sage 300 ERP Learning Center

The Learning Center is where you'll find documentation for new product
features and modules in the Sage 300 ERP Portal. It features articles and
information about the portal, shortcuts, snapshots, and Inquiry.

You view the Learning Center in one of the following ways:

l Open the Sage 300 ERP Portal, and on the welcome bar at the top of the
screen, click Help > Learning Center.

l On the tab menu for any portal tab, click Help.

Context-Sensitive Help

Sage 300 ERP features context-sensitive help that you can use to quickly open
and view articles and information directly from Sage 300 ERP screens.

l In the Sage 300 ERP Portal, click Help on the tab menu to view help for
the current screen.

l On the Sage 300 ERP Desktop, press F1 to view help for the current screen.

Product Documentation

Sage 300 ERP includes guides in printable PDF format, including the
Installation and Administration Guide, Upgrade Guide, and other
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documentation related to installation and setup.

These guides are available in the Docs folder on the Sage 300 ERP server, and
online in the Sage Customer Portal at:

l https://customers.sagenorthamerica.com/irj/go/km/docs/sageKM/Sage
Accpac ERP/Ungated Customers/Browsable/Product
Documentation/Accpac_UA_Resources.htm.

To view the guides in the Docs folder:

l On the Windows taskbar, click Start > Programs > Sage 300 ERP >
Documentation.

Sage Payment Solutions Support
Sage 300 ERP Payment Processing uses Sage Payment Solutions to process
credit card transactions.

To find support and services for Sage Payment Solutions, Sage Exchange, and
Sage Virtual Terminal, use the following resources:

l Self Service Portal. Visit the Self Service Portal at na.sage.com/sage-
payment-solutions to search the Knowledge Base, browse merchant forms
and resources, or contact the Sage Payment Solutions support team.

l Sage Virtual Terminal. Sign in to Sage Virtual Terminal at
https://www.sagepayments.net/virtualterminal and use the Help menu to
find step-by-step tutorials.

Sage 300 ERP Support

To find support and resources for Sage 300 ERP:

l Customer Portal. Visit the Customer Portal at
https://customers.sagenorthamerica.com to search the online Knowledge
Base, submit a question via email or chat, or submit a service request.

l Sage 300 ERP website. Visit the Sage 300 ERP website at
http://na.sage.com/sage-300-erp/product-support to learn about business
care plans, professional services programs, and training and education for
Sage 300 ERP.
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